
VisiLogic V9.8.91 Bugs Fixed  

Fixed in this version: 

• Signature Log - column PLC Reset was not updating properly. 
• UDP RAW SCAN/Send was missing socket 3 
• Ladder editor (Win 10) – Page up/down Scroll bar is not working 
• In some case when opening a project that contact “Duplicated tags” an error was generated 
• In some cases import/export operand descriptions CSV failed 
• CANopen SDO upload did not work in certain cases 
• Remote IO Configurator had Zoom issues 
• Unable to download applications with COM INIT to standard Vision and EX-RC1. (Return Error 

message: Unable to get data from: Ladder Tokens) 
• Adding VFD to samba or V130 generated error due to operand addressing 
• Struct: Copy Mixed Data – overwrite warning: when importing a URB I/O configuration, the 

import can over-write vectors that are already in use; a message box now appears to warn the 
user. 

• In some cases there was no option to download application to EXF-RC15 
 
VisiLogic V9.8.90 Bugs Fixed  

No bugs were reported in the previous version 

 
VisiLogic V9.8.80 Bugs Fixed  

Fixed in this version: 

• UDP RAW – Socket Numbering Issue: sockets were numbered, depending on the controller 
model, from 1-3 or 1-8. The numbering has been adjusted to 0-3 or 0-7, depending upon the 
number of sockets in the controller model. 

• Write to .csv: the modified date attribute did not update. 
• EHS6T GPRS: in certain cases did not register successfully. 
• Hardware Configuration: In some cases no scroll bar appeared. 
• EXF-RC15 – PCOM over CAN was not working after power cycle. Fixed. 

 
 
VisiLogic V9.8.79 Bugs Fixed  

Fixed in this version: 

• SD CSV logging: in certain circumstances, the File Modified Date was not updated. 
• VisiLogic print: in portrait mode, only one page could be printed. 

 
 
VisiLogic V9.8.65 Bugs Fixed  



• SAMBA – The RS485 for COM2 is now visible in COM INIT. 
• Data Table grid scroll bar width is now standard.  
• Trend - Title of operand window to matching to variable field. (Trend Load Error bit).  
• Ladder Printing improved – in some case the text of subroutine name was on top of ladder 

elements.  
• Remote Operator for Mobile – Alpha Numeric Keyboard is now visible for V700/V1040/V1210  
• Mail Date Header was fixed. 
 

VisiLogic V9.8.64 Bugs Fixed  

• Timer operands used as Jumps generated an unnecessary jump. 
• If a project set to Samba includes a Socket Init function set to protocol HTTP, a compilation 
error now results. (Samba does not support web server) 
• "IsDisplayed" operand is now always reset at powerup. 
• Deleting the Webserver now removes all pages, include the default. 
• SI222 - Number of RTR NMT message objects in the buffer waiting to send is set to a maximum 
of 12, from 8 to 12 
 

VisiLogic V9.8.22 Bugs Fixed  

V430/SM43 Text Color Black Text sometimes appeared blue in these models. 

 

VisiLogic V9.8.00 Bugs Fixed  

HMI Tank Element Including a Tank Element on the HMI screen caused an error 
message to be displayed. 

Additional Issues This version included some minor bug fixes. 

VisiLogic V9.7.44 Bugs Fixed  

Combo Boxes Did not open randomly 

Printing Minor issues 

 

 



VisiLogic V9.7.24 Bugs Fixed  

Samba • Program sections that were imported containing SD 
functions, did not give a compilation error. 

• Certain issues relating to application size, including images, 
have been fixed 

SMS Send function Double-clicking on an SMS Send function sometimes caused 
VisiLogic to close. 

Clone Files Certain Clone files produced using VisiLogic  9.70 had issues with 
images. 

Save icon The Save icon appeared to be disabled both when opening a new 
project, and loading project.  

VisiLogic V9.7.0 Bugs Fixed  

No bugs were fixed in 9.7.0  

VisiLogic V9.6.0 Bugs Fixed  
(these are fixed in the current version) 

Export/ import 
Operands 

Did not successfully import System Operands. 

Did not support Reset Option after Import. 

Data Tables If a table contains Part of Project with an odd number of bytes, a warning 
message is displayed. If the table is to be opened in an external utility such 
as SD Suite, you must add a new table comprising a single row of a single 
column type bit/Boolean. 

PTO When Stop was triggered during acceleration, deceleration did not begin 
from the actual current value, but from the maximum value. 

FB Protocol Stream variable did not always receive the correct number of bytes. 

Alarm Acknowledge Did not always function correctly. 

Hardware 
Configuration 

TRA22: the icon displayed for NPN and relays was identical. 

 

VisiLogic 10.4"/12.0" 
project 

A project with a user-defined splash screen, when converted to V570 might 
cause the PLC to lock while trying to draw the image. 



 

Print HMI V1040 and V1210 did not always print relevant size of display. 

 

VisiLogic V9.5.0 Bugs Fixed  
(these are fixed in the current version) 

PTO Various improvements 

V130 String 
Library 

Library was not downloaded after editing. 

  
  
VisiLogic V9.4.0 Bugs Fixed  
(these are fixed in the current version) 

Customized 
Splash Screen 

Was not shown in certain circumstances. 

Trends from SD Improved handling 

String Library Was sometimes unnecessarily downloaded, which 
increased Download time. 

Leading Zeroes 
in IP addresses 

Caused connection errors. 

PTO •         List of elements in Find window did not match the 
list of PTO functions in Utilities menu 

•         A Move function taking place while another Move 
was active did not function as expected. 

•         Did not always operate the right transistor 
outputs. 

Font limit Exceeding the legal limit regarding the number and 
volume of fonts, sometimes led to a PLC error after 
download. As of this version, a warning is displayed to 
the programmer to prevent download. 

PID In certain circumstances, PID parameters were set to  
“-1” by Autotune 



  
  
  
VisiLogic V9.3.1 Bugs Fixed  
(these are fixed in the current version) 
HMI Variable: 
Numeric Keypad 
Entry 

If Minimum and Maximum values are out of the range 
of the linked register, it is not possible to enter any 
numeric data. This will now be marked by a Compile 
error. 

Downloading via 
Ethernet 

This sometimes resulted in downloading incompatible 
system files. The Ethernet Download Wizard added in 
this version simplifies the download process to help 
prevent this issue 

HMI Variable: 
Numeric Range 

In certain cases, Defragmentation lost/changed certain 
pre-defined data. 

Trend to SD If, when Trend History was being displayed, a 
corrupted Append section was reached, the PLC 
remained Busy, and the user could not skip forward to 
the next section. Now, the user can skip to the next 
valid section. 

Find  Did not find: 
 - String Library fonts. 
 - bit linked to ‘HMI Display Loaded’ 

V350 In certain cases, the BINLIB file did not download 
correctly. 

Alarms Alarm Details text was not always optimally displayed 
V1040 In certain cases, the user was unable to press two 

keys simultaneously. 
PTO Several small bugs have been fixed. 
V290 Improved support. 
HMI Display text In certain cases, the text from the String Library was 

taken from the wrong row number. 
  
  
VisiLogic V9.3.0 Bugs Fixed  
(these are fixed in the current version) 

Hardware 
Configuration, 
model switch 

Switching from V130 to V120 caused a new project to be opened. 

DF1 Reading a value ending in 10 hexa resulted in an extra byte. 



Data Table 
Read Row 

Read Row caused an RTE if a row was empty. 

Alarms • V1040 
Text strings exceeding the length limits were extended off the 
Alarm screen. 

• Alarms configuration 
Save and Add New did not automatically jump to the next 
unused MB and text content 

String Library 
V130 

When number of libraries was changed, no message was given that the 
capacity per library would change, and that data night be truncated. 

SD Browser In some projects, the function could not be assigned to the desired SD 
folder. 

CANopen Opening an older CANopen project caused an RTE. 

SD Create 
Excel 
Delimited 

An empty field for binary text resulted in an RTE. 

Netbooks: 
Online mode 

When using Online Test mode on a small screen netbook, clicking a 
ladder element caused the popup window, which enables the user to 
edit operand values, to open--but the popup was not visible on the 
screen. 

VisiDiff Improved function with this release. 

  
  
  
VisiLogic V9.2.0 Bugs Fixed  
(these are fixed in the current version) 
Transparent images Are now supported on all color models (65536 colors) 

J1939 Improvements in configuration. 

PTO utility  
(PTO-enabled 
v130/350 models 
only) 

• Fixes normal stop on Accelerate phase 
• Protect user from trying to run undefined PTO channels. 
• Updated status messages in Configuration and Stop modules 
• Prevent reverse movement in PTO Stop 

System text Now properly aligned on screen 

Password String 
variable 

Using arrows generated error. 

SD files: Data Table The related SIs - maximum number of DT files (SI64) and max 



and Trend number of trend files (SI63) - now functionas expected 

DF1 Improved handling 

  
  
VisiLogic V9.0.1.Bugs Fixed  
(these are fixed in the current version) 
None   

  
  
VisiLogic V8.6.3 Bugs Fixed  
(these are fixed in the current version) 
HMI Editor View 
default 

· In V8.6.2, the Editor opened in Zoom mode; the jumps were not 
visible. 

Ladder Bug · Placing MODBUS elements sometimes caused an RTE. 

  
VisiLogic V8.6.2 Bugs Fixed (these are fixed in the current version) 

HMI, Enhanced Vision 
only 

· HMI Editing + Zoom: HMI changes created during Zoom were not 
always saved 

Hardware 
configuration 

· I/O options did not show Normal/Fast resolutions for models: 
V350-35-TRA22, V130-33-TRA22, V130-35-TU24 

  
VisiLogic V8.6.1 Bugs Fixed  
(these are fixed in the current version) 
String Library, .csv 
import 

This is no longer dependant on Microsoft Office being installed on 
the PC. 

Built-in Web server 
configuration 

· If memory was exceeded, no error message was given at 
compilation; one was added. 
· Memory allocation graph was inaccurate 

V350-35-TU24 Selection modes added: fast/Normal for volt/current 

MODBUS IP 
Configuration 

Changing slave parameters in MODBUS IP Configuration did not 
update the slave parameter descriptions in MODBUS commands. 

Right-to-left 
languages 

In Data Table cells, there was no right-align option 

SD Card functions, 
busy bit 

Notes regarding busy bits were added to some functions 

PLC Name, illegal 
chars 

Accessing a PLC named using illegal ASCII characters caused RTE, 
now shows error message 



Search Did not find HMI ‘is Displayed’ operand 

V130 Binary images were not displayed properly on image 

Data Table import In certain cases VisiLogic could not import data table’s structure & 
values from the PLC. 

Built-in Web server When converting a project from previous VisiLogic version to 8.6.0, 
Web server configuration was lost in some specific cases 

Thermometer, Remote 
Access 

Did not display decimal point in Remote Access 

HMI functions Problem with translating few of the HMI functions 

Import operand 
description 

When canceling import operand description, the selected file was 
imported anyway. 

Save & Close operand, 
dual screen 

When an operand was saved and closed on a secondary screen, and 
the screen was disconnected, the operand could not be opened from 
the primary screen 

Font Handler Deleting a font sometimes caused HMI text elements to lose text. 

SD Excel Create 
Delimited line 

When configuring List By Value – from some point received RTE 

  
VisiLogic V8.6.3 OS V2.1.31 
Bugs Fixed (these are fixed in the current version; OS update required) 
Operands Kept their values (MB468 =1 and MB469 = 0) independent of 

application logic and was not possible to be operated. 

Trends (Enhanced 
models) 

R.T.E. after changing curve properties while HMI is not active. 
When applying changes to trends and curves on Project tree, the 
whole tree redrawn itself, causing it to collapse or be annoying to 
users. 

GPRS - Enfora 
modems 

If the PLC closes the socket, instead of normally close the socket, it 
caused socket error. This prevented VisiLogic from returning to 
Listen mode. 

Alarms Define Alarm description in string 4095 in String Library #2 led to 
R.T.E. 

HMI Meter variable (V130) – when trying to change decimal point 
in "Ranges" tab using Up/Down arrows, it changed the 
Min/Max values instead. 
When trying to copy element "Timer to ASCII" or to 

export subroutine which contains this element an 
error message: "The selection contains elements that 
reference named constants" appeared and copy/paste 



was not possible. 
HMI – Numeric variable - The Text after was not 

appearing in the HMI element and therefore Fit To 
Size would cause the size to fit the format 
9.99999999 without the text after. 

HMI – Fonts - After importing displays that contain fonts 
that already exist in the project – the font handler 
add the same fonts again. If System fonts were used, 
then the added fonts are also "system" and cannot be 
deleted. 

HMI - LED bar variable – lighted again the first LEDs on 
higher values, keeping the last few LEDs black. 

HMI In "color" models (V350/570) there was a possibility 
to add elements on top of vars. If you draw a variable 
and then on top of it – for example text element, in 
VisiLogic it was looking OK, but not in the controller. 

If HMI module's name was longer than 25 characters, 
while downloading, RTE occurred. Now HMI module's 
name can be up to 50 characters. 

In Vista loaded PC, parameter's text was not visible 
(black field). 

Trying to type Cyrillic in String Library or SMS 
Configuration – the text was messed 

TCP/IP Card Init block - In VisiLogic projects, created with V6.01, after 
opening Card Init, the values for IP address, Subnet mask and 
default gateway was messed. 

Hardware 
configuration 

V530 project with V200-18-E6B snap In module – after upload HWC 
data was messed. 

  
VisiLogic V7.0.1 OS V1.002 (B7)  
Bugs Fixed (these are fixed in the current version; OS update required) 
Project conversion, V120-V130 In some cases, conversion hung and did not complete. 

Project conversion, Enhanced, 
String Library 

The number of strings in a library of each model is 
different. This sometimes lead to errors during 
conversion. 

Snap-in I/O module, V200-18-
E6b 

In Hardware Configuration, the analog input resolution 
was always Normal. 

Data Table: Find row Extended 
function 

There was no option to choose Boolean operand. 

Data table using write If the Write option in the Data Table window was used to 
set multiple Boolean elements, only the first element 
stayed set. 



Disable View property When an MB was assigned to Disable View property for 
Binary text variable, the user would click OK, but would 
not see the MB in the Properties. 

Download project A project close to 64K in size would sometimes fail to 
download. 

VisiLogic V6.0.1 OS V1.002 (B7) 
Bugs Fixed (these are fixed in the current version; OS update required) 

Trends HMI Certain projects containing Trends HMI object would 
automatically run Defrag resulting in a run-time error. 

Subroutine Import/Export Sometimes resulted in a run-time error. 

Small HMI Images Images smaller than 8 by 8 pixels may have 
-Displayed incorrectly 
-Influenced other pixels in the same display 

  
OS V1.002 (B05 V570 and V130 only 
Bugs Fixed (these are fixed in the current version; OS update required) 
MF 3 When MF3 held a value other than 0, there was a power-

up error 
To obtain an updated OS: 
· V570: From VisiLogic, run Update from the web: 
Help>Check for updates>Operating Systems 
· V130: Contact support@unitronics.com in order to 
receive the correct OS version 

  
OS V1.002 (B03), V570 and V130 only 
Bugs Fixed (these are fixed in the current version; OS update required) 
MODBUS, Serial and TCP/IP 
Read/Write Coils 

Read: When a vector of coils was read, the coil 
immediately after the vector was reset. For example, 
reading coils 5,6,7 would reset coil 8 in the master. 
Write: When a vector of coils was written, the coil 
immediately after the vector was reset. For example, 
reading coils 5,6,7 would reset coil 8 in the slave. 
To obtain an updated OS: 
· V570: From VisiLogic, run Update from the web: 
Help>Check for updates>Operating Systems 
· V130: Contact support@unitronics.com in order to 
receive the correct OS version 

  

mailto:support@unitronics.com
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VisiLogic V6.0.0 OS V1.002 (B2) 
Bugs Fixed (these are fixed in the current version; OS update required) 
FB PWM When Duty cycle reached 100% maintained that level for 

a period of time, and then decreased, the output bit was 
"stuck" at "1. 

HMI Timers, Keypad Entry When set to format HH:[MM:SS:hh] – 23 was the 
maximum number that could be entered in HH. 

Info mode>Serial The strings for COM port 3 (V570) were not visible. 

  
VisiLogic V5.2.3  
Bugs Fixed (these are fixed in the current version) 
Communications>PC 
Settings>Initialize & Reset 

Clicking the Initialize and Reset button did not always 
carry out the action. 

  
V570/290–C Firmware lower than: O/S 1.1 Build 07 
PLC – Failure If the operator used the touch panel to enter a numeric 

value (HMI or INFO) while MI 166 = 32, the PLC 
watchdog was activated immediately when any touch 
element was pressed. 

  
VisiLogic V5.2.2 Bugs Fixed  
(these are fixed in the current version) 
VisiLogic ‘remains active’ When VisiLogic was closed, some VisiLogic processes 

remained to be active, and had to be shut down via 
Windows Task Manager. 

Trends Data Overflow message removed 

Upload failure ‘Full Download’ programs could not be uploaded 

Find and Replace ‘Find and Replace’ utility did not actually replace 
operands linked to HMI elements 

Memory Requirement message V570 only: A Compile error message was displayed when 
the FB memory requirement exceeded 8K—even though 
the actual V570 memory capacity is 32K. 

  
VisiLogic V5.2.1 Bugs Fixed  
(these are fixed in the current version) 
VisiLogic Shutdowns This version of VisiLogic should be more stable. 

GPRS Improved GPRS communication. 



V570/290-C:  
SMS Receive 

Did not function properly in projects that contained 
certain other FBs 

V570/290-C: 
Immediate Write to Output 

Did not work. 

Data Tables · Part of Project now supports up to 128 KB 
· Data Tables> File> Memory Requirements> Part of 
Project tab: Memory usage shown is now accurate, OS 
update required. 

New Compilation Error "Net Logic too complex, contains Call Subroutine and 
Load HMI functions".  
Such a net should be divided into two or more nets. 

Negative numeric variable In hex/binary base showed “****”. 

Float to ASCII String Did not operate properly. 

Numeric Keypad password Pressing Enter caused an extra character to be added, 
resulting in an incorrect password. 

Keypad Entry Format X.X was not 'friendly'. 

Keypad entry with linearization Negative numbers were not displayed properly. 

V570/290-C: Keypad Entry: 
Timers 

When Timer preset values were changed via HMI or 
Ladder program, at Power-up values reverted to project 
values. 

HMI Binary Variable, Switch 
feature 

Using 'Switch' caused HMI to freeze on Load Display. 

Protocol FB, Serial “Checksum + ETX” returned an incorrect checksum. 

Protocol FB, IP When configured, INFO Mode showed ERROR. 

V290-BW The PLC would hang when CANbus communication and 
Virtual Keypad ran at the same time. 

  
  
 


